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1 Welcome

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that
can be used to monitor and control assets in space or on the ground. The TReK CFDP
application provides the capability to transfer files using the Consultative Committee for
Space Data Systems (CCSDS) File Delivery Protocol (CFDP).

This tutorial provides step-by-step instructions describing how to perform common
application functions.

This tutorial uses screen dumps taken on a Windows computer. However, the steps are
the same regardless of whether you are running on Windows or Linux.

2 Technical Support

If you are having trouble installing the TReK software or using any of the TReK
software, please contact us for technical assistance:

E-Mail: trek.help@nasa.gov
Messages sent to this address are automatically forwarded to the TReK team.

The HOSC Help Desk (256-544-5066) can provide assistance as needed and is available
24X7.

3 Introduction

The TReK CFDP application provides the capability to transfer files using the
Consultative Committee for Space Data Systems (CCSDS) File Delivery Protocol
(CFDP).

The CCSDS File Delivery Protocol (CFDP) was developed by the Consultative
Committee for Space Data Systems (CCSDS). Official specifications are contained in a
CCSDS document called the CFDP Blue Book (available at www.ccsds.org). The CFDP
protocol provides reliable transfer of files from one computer to another and has been
designed to work well over space links. It can be used to perform space to ground,
ground to space, space to space, and ground to ground file transfers.

CFDP requires a sender and a receiver. The sender and receiver must be configured and
running at the same time to perform a file transfer. Each party is referred to as an
“Entity”. The sender is an entity and the receiver is an entity. Each “Entity” must have a
unique Entity ID. For example:


http://www.ccsds.org/
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Computer 1 CFDP Computer 2
CFDP Application o = CFDP Application
Entity 1D (EID) 1 Entity 1D (EID) 2

Figure 1 CFDP Sender and Receiver

To move a file from one computer to another, you will enter one or more CFDP
Commands (primitives) to indicate the action to be taken.

The TReK CFDP application provides support for CFDP using the following modes:

e Native CFDP or CFDP over User Datagram Protocol (UDP) using a Goddard
Space Flight Center (GSFC) CFDP library that performs the CFDP work.

e |ON CFDP or CFDP over Bundle Protocol (BP) using the Jet Propulsion Lab
(JPL) Interplanetary Overlay Network (ION) Delay Tolerant Networking
software. In the ION CDFP configuration, the TReK CFDP application
communicates with the ION software which performs the CFDP work.

There are differences in capabilities and syntax between the CFDP Native mode and the
ION CFDP mode. These differences are summarized below.

Native CFDP Configuration
The syntax of a primitive is as follows:

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]
Native CFDP Example: put class2 “D:\filel.txt” 2 “/home/username/filel.txt”

The TReK CFDP application currently supports multiple CFDP Directives defined
below.

Valid Transmission values are classl or class2. Classl does not guarantee reliable
delivery of the file to the destination. Class2 does ensure reliable delivery.

The file you want to transfer is considered the “Source” and the location it should be
transferred to is considered the “Destination”.

When entering a Source or Destination in a CFDP command line, it must be encapsulated
in double quotes.

ION CFDP Configuration
The syntax of a primitive is as follows:

[CFDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]

ION CFDP Example: put //// “D:\filel.txt” 2 “/home/username/filel.txt”
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The TReK CFDP application currently supports multiple CFDP Directives for both
Native and ION CFDP modes. These are defined in the CFDP Directives section below.

The Transmission entry for ION CFDP is composed of five properties. Once these
properties are configured, a “////” string is used to indicate that the pre-configured values
should be used. The ““////” nomenclature is shorthand notation for the following
combination of values:

Lifespan/Bundle Protocol Class of Service/Expedited Priority Ordinal/Transmission Mode/Criticality

When the values are empty it indicates that pre-configured values should be used for
these properties.

A summary of the ION CFDP Transmission properties is provided below in Table 1. For
details, please reference section Error! Reference source not found..

Property Description

Lifespan The lifespan is the bundle's "time to live” (TTL) in
seconds. The bundle is destroyed if its TTL has
expired, and it has not reached its destination.

Bundle Protocol Class of Service | The Bundle Protocol Class of Service defines the
transmission priority of outbound bundles from three
ION priority queues corresponding to bulk, standard,
and expedited priorities. The expedited priority
queue must be empty before bundles in the standard
or bulk queues are serviced by ION. Therefore,
bundles with expedited priority should only be sent in
critical/emergency situations.

Expedited Priority Ordinal The expedited priority ordinal is only associated with
the expedited priority class of service.
Transmission Mode The transmission mode defines the reliability of

bundle delivery to a destination. The three
transmission modes supported are best effort, assured,
and assured with custody transfer.

Criticality A critical bundle is one that has to reach its
destination as soon as is physically possible. For this
reason, bundles flagged as critical may not include
custody transfer and require an ION configuration
with contact graph routing. In some cases, a critical
bundle may be sent over multiple routes to ensure
delivery to its final destination. Critical bundles are
placed in the expedited priority queue and should
only be used in emergency situations.

Table 1 ION CFDP Transmission Properties
CEDP Directives
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The TReK CFDP application currently supports multiple CFDP Directives for all CFDP
modes. This includes get and put, multiple filestore directives, and the message directive.
These are defined in Table 2 below:

Directive Description

append_file? Append a file at the remote entity to another file at the remote
entity.

bit_rate’ Changes the aggregate file transfer bit rate, in real time, for local

or remote entities hosting a TReK implementation of Native
CFDP. The “affected EID” may be the local entity ID or a remote
entity ID. The "bit_rate" primitive is delivered to a remote entity
in the form of a TReK CFDP message.

close_rec_file®*

Send a directive to a TReK Record library to close one or all open
record files. If the record file name is not included in the
primitive, all open record files associated with the TReK Record
library are closed. The TReK Record library automatically opens
a new record file after it closes a current record file. The “affected
EID” may be the local entity ID or a remote entity ID. The
"close_rec_file" directive is delivered to a remote entity in the
form of a TReK CFDP message.

create_dir? Create a directory at the remote entity.

create file? Create an empty file at the remote entity.

delete file? Delete a file at the remote entity. Will fail if file does not exist.

deny_dir? Delete a directory at the remote entity. (like remove_dir, but does
not fail if the directory does not exist. Directory must be empty.)

deny_file? Delete a file at the remote entity. (like delete_file, but does not fail
if the file does not exist)

get! Dopy one file from the remote entity to the local entity. (File
cannot be empty.)

message? Send a text string to the remote entity.

put Copy one file from the local entity to the remote entity. (File
cannot be empty.)

remove dir? Delete a directory at the remote entity (directory must be empty).

rename_file? Rename a file at the remote entity.

replace_file? Replace a file (contents) at the remote entity with another file

(contents) at the remote entity.

Table 2 CFDP Directives

! _ Not supported in all CFDP implementations. Requires TReK on send and receive

side.

2 — Not supported in modes using the GSFC library unless it has TReK enhancements.
3 _ Not a CCSDS standard. Implemented outside of standard.
* _ Requires the TReK Record Library.
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Some directives only require a Source. The following table describes what is required for
Source and Destination for each directive. Name of file, filename, and name of directory
refer to an absolute path.

Directive Source (first file) Destination (second file)

append_file? Name of file whose contents Name of file whose contents will form
form first part of new file and | second part of new file
name of the new file

bit_rate Aggregate file transfer bit rate

close_rec_file®* | Name of the TReK record Name of the TReK record file to close
library device (if not included all record files

associated with the record device are
closed)

create_dir? Name of directory to be
created

create file? Filename to be created

delete file? Filename to be deleted

deny_dir? Name of directory to be
deleted

deny file? Filename to be deleted

get! File or directory name of File or directory name for file(s)
file(s) to retrieve retrieved

message? Message

put File or directory name of File or directory name for file(s) sent
file(s) to send

remove_dir? Name of directory to be
deleted

rename_file? Old filename New filename

replace_file? Filename whose contents are | Filename whose contents will replace
to be replaced the contents of the first filename

Table 3 CFDP Directives Source/Destination Requirements

TReK also provides the capability to create several different types of dropboxes. These
include CFDP dropboxes, Fragmentation dropboxes, and Cryptography dropboxes.
These dropboxes are available in all CFDP modes. Dropbox configuration parameters
include where the dropbox is located and the destination of each file placed in the
dropbox. CFDP dropboxes can be used to push files to a remote destination.
Fragmentation dropboxes can be used to split a file into smaller fragments and
reassemble it, and Cryptography dropboxes can be used to encrypt and decrypt files.
Dropboxes can be used together. For example, the CFDP and Fragmentation dropboxes
can be used to transfer a very large multi-Gigabyte file in fragments, and the CFDP and
Cryptography dropboxes can be used to encrypt a file prior to transferring it using CFDP.

In addition to this application, TReK also includes a CFDP console application and a
CFDRP library. If you need CFDP functionality onboard a spacecraft consider the TReK
CFDP console application. If you need to include CFDP functionality in your own
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application, consider the TReK CFDP library. The TReK CFDP library can be used to
include CFDP functionality in a ground or flight application.

4 Overview of the User Interface

41 Main Window

The main window contains several areas as shown in Figure 2. Each area is a dock
window that you can float or dock. To float a dock window, use your left mouse button
to click and hold the title area while dragging the window to another area of the screen.
To dock, use the title bar to drag the dock window over the main window and drop.

[ TReK CFDP -- Untitled - u] X
File View CFDP Options Help
Configuration: . Configure | Operational: . Activate Deactivate
CFDP Comman ds g X
Action  Transmission Source Remote EID Destination Add Row
Remove Row
Export List
Import List
<< Show Directory Default Destination: None ~ Clear All Restore All Execute All
Transactions g X
Transaction |0 Action Remote EID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
Configure. .. Clear Pause Resume Cancel
Message Area 5 x

Figure 2 Main Window

Toolbar
The toolbar at the top of the window provides quick access to configure the application
and start and stop the CFDP service.

CEDP Commands

The CFDP Commands area provides a way to add and execute one or more CFDP
commands (primitives). For example, you can add a “put” command to send a file to a
remote entity. The “Show Directory” button provides access to the local file system.
Files can be dragged from this view of the local file system or from a file explorer
window. Files can also be added by pushing the Add Row button and typing in the file
transfer information. To delete a file from the list put your cursor in the row you would
like to delete and push the Remove Row button. To delete all files in the list push the
Clear All button. The Export List button provides a way to save the list of CFDP
Commands in a file. The Import List button provides a way to load a list of CFDP
Commands from a file. Each CFDP command entered into the list must include a
directive, transmission information, the absolute path of the source file, the Remote
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Entity ID (Remote EID), and the absolute path of the destination file. To execute all the
CFDP commands in the list, push the Execute All button. After you push the Execute All
button, the Restore All button can be used to restore the list of commands. The Restore
All button will only restore the list of CFDP commands previously sent by pushing the
Execute All button. The Default Destination menu can be used to identify a default
destination. This can save typing when dragging and dropping files into the list. If the
Default Destination is set, the destination selected will automatically be copied into the
Destination field when a file is dropped into the list. The Default Destination menu can
be populated using the Configure dialog.

Note: You can enter the absolute path for a directory in the Source and Destination
fields. All the files in the first level of the directory will be transferred. Subdirectories
will not be transferred. Each file in the directory will result in the execution of an
individual CFDP Command (primitive). Therefore, the transactions area will contain
transaction information for each file transferred.

Note 2: There are two types of configuration files for the CFDP application: the CFDP
Application Configuration File and the CFDP Commands List file. File/Save/Save As
can be used to save an Application Configuration File. The File/Open command provides
a way to open an Application Configuration File. The Export List button provides a way
to save a CFDP Commands List file. The Import List button provides a way to load a
CFDP Commands List file.

Transactions

The Transactions area displays file transfer activity. The Configure button displays the
Configure dialog which provides a way to show and hide columns and rearrange the
order of the columns. To Clear, Pause, Resume, or Cancel one or more transactions,
select the transactions in the list and push the desired button.

Message Area
The Message Area displays important status and error messages. The message area can

be cleared using the View menu.

4.2 Toolbar

The toolbar provides visual information about the state of the application and provides
access to common application functions.

Configuration Status

When the Configuration status is black, this indicates the application has not been
configured. When the Configuration status is green, this indicates the application has
been configured and the CFDP service can be activated.

Use the Configure button to access the Configure dialog to configure the application.
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Operational Status

When the Operational status is black, this indicates the CFDP service is inactive. When
the Operational status is green, this indicates the CFDP service is active and file transfer
is supported. The application must be properly configured before the Activate button will
be available. The CFDP service must be active before the Deactivate button will be
available.

Use the Activate button to activate the CFDP service. This will initiate all internal
activities needed to prepare the application to send and receive files. When you activate
the CFDP service, you will see activation status messages in the main window message
area. If you need to reconfigure the CFDP application, deactivate the CFDP service, and
then push the Configure button to reconfigure.

5 TReK CFDP Tour

Sometimes it’s easier to learn how to use an application by example. This section
describes how to use the CFDP application to transfer a file using Native CFDP.

This section was written assuming that you have read the Introduction section and the
Main Window section. If you have not read these sections, please go back and read
them. They contain important information that is not repeated in this section.

If you have a firewall enabled on your computer, you may need to turn it off or allow
traffic through for the ports and protocols used in this example.

Please go through the tour in order. Some sections depend on data from previous
sections.



5.4.0 1SS TREK-USER-0006

How to Transfer a File
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5.1 How to Transfer a File

The following steps describe the minimum necessary to transfer a file using Native
CFDP. Typically CFDP involves transferring files from one computer to another
computer. An instance of the CFDP application is run on each computer. The two CFDP
applications communicate with each other using the CCSDS File Delivery Protocol
(CFDP). While normally you run an instance of the CFDP application on each computer,
it is possible to run two instances on the same computer (doesn’t make a lot of sense but
is possible). In this configuration, you can transfer a file from one directory to another
directory on the same computer. To avoid the need for two computers, this is the
approach taken in this tutorial. The steps below describe how to use two instances of the
CFDP application running on the same computer to transfer a file from one directory to
another directory on the same computer using Native CFDP. The configuration that will
be used is shown in Figure 3.

CFDP Instance 1 CFDP Instance 2
Entity 1D (EID) 1 CFDP Entity 1D (EID) 2
e e
<Your Local IP Address= [~ “|=¥our Local IP Address=

Local Part 4560 Local Port 4545

Figure 3 Tutorial Configuration

While you will be doing this on a single computer, the steps to configure and run will be
the same steps when you do this with two computers.

Step-By-Step

1. Ifyou haven’t started the CFDP Application, use the operating system’s menu to start

the application. You should see the CFDP main window shown in Figure 4. We will
refer to this instance as CFDP Instance 1.

10
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[ TReK CFDP -- Untitled - m] X
File ¥iew CFDP Options Help
Configuration: [[ll | Configure | Operational: [l Actuate Deactivate
CFDP Commands =
Action  Transmission Source Remote EID Destination Add Row
Remove Row
Export List
Import List
<< Show Directory Default Destination: MNong Clear All Restore All Execute All
Transactions =
Transaction [0 Action RemoteEID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
Configure... Clear Pause Resume Cancel
Message Area =

Figure 4 CFDP Main Window

11
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2. The Configuration Toolbar at the top of the main window contains a Configure
button. Push the Configure button to display the Configure dialog. You should see
the dialog shown in Figure 5.

B Configure 7 x

Configuration: @ Mative CFDP O 10M CFDP

Native CFDP Options Cryptography Summary

Remote Entities

Remote EID  Remote IP Address  Remote Port Add
Delete
CFDP Socket Local TP Address: [192.158.56.1 || Browse...
CFDP Socket Local Port: [a580 |
CFDP Socket Queue Size: 1000 |
Ack Timeout (seconds): | 15 |
Ack Limit: [25 |
MNak Timeout (seconds): | 15 |
Nak Limit: 100 |
Mak Maximum PDU Packet Size (bytes): | 15000 |
Inactivity Timeout (seconds): | 300 |
Outgoing File Chunk Size (bytes): [1300 |
Aggregate File Transfer Rate (bits/zsec): | 10000000 |
Transaction Cyde Time Interval (miliseconds): | i |
Steps Per Transaction Cyde: | 10 |

[ Auto suspend and Resume

Mode: Peer to Peer Mode
Port: 45600

Connection Timeout (seconds): |3

Automatically Resize Nak Maximum PDU Packet Size if the Mak Packet Times Out

oK Cancel

Figure 5 CFDP Configuration Dialog

3. Ensure Native CFDP is selected. The Local Entity ID is the Entity ID that will be
used by this CFDP application when it performs a file transfer. It defaults to 1.
This is the EID that should be used by CFDP Instance 1.

Note: If you have identified you will be using the CFDP capability in your
Payload Integration Agreement, you will be assigned a “Ground Node ID”. The
Ground Node ID is an Entity ID and should be entered into the Local Entity ID
field. If there are multiple people on your team, your team may have more than
one Ground Node ID. Each team member who needs to run the CFDP application
will need a unique Entity ID.

12
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4. The next step is to identify the remote entity that this CFDP application will
communicate with. This will be CFDP Instance 2 (which we have not started
yet). Push the + button to create a row to enter the Remote Entity information.

Type in the following information:

Remote Entity ID: 2

Remote IP Address: <Your Local IP Address>

Remote Port: 4545

Note: The CFDP application can communicate with one or more remote entities.

Your dialog should now look similar to the dialog shown in Figure 6.

Configure ? X
Configuration: @ Mative CFDP O IOM CFDP
Mative CFDP Options Cryptography Summary
Local Entity ID: |1 |
Remote Entities
Remote EID  Remote [P Address  Remote Port Add
2 192.168.56.1 4545 Delete
CFDP Socket Local TP Address: [182.188.56.1 | | Browse...
CFDP Socket Local Port: [4s60 |
CFDP Socket Queue Size: 1000 |
Ack Timeout (seconds): | 15 |
Ack Limit: |25 |
Mak Timeout (seconds): | 15 |
Nak Limit: 100 |
Nak Maximum PDU Packet Size (bytes): 16000 |
Inactivity Timeout {seconds): |SDD |
Outgaing File Chunk Size (bytes): [1300 |
Aggregate File Transfer Rate (bits/sec): | 10000000 |
Transaction Cyde Time Interval (milliseconds): | 1 |
Steps Per Transaction Cycle: | 10 |
[ auto suspend and Resume
Mode: Peer to Peer Mode
Port: 45600
Connection Timeout (seconds): |2
Automatically Resize Mak Maximum PDU Packet Size if the Mak Packet Times Out
oK Cancel

Figure 6 Configuration with Remote Entity

13
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5. Ensure the CFDP Socket Local IP Address and the Remote IP Address contains your
local IP address.

6. All the other defaults in the dialog are acceptable.

7. Push the OK button to save the configuration information and exit the dialog.

8. If the application is configured correctly, the Configuration status in the main window
will be green as shown in Figure 7. If you do not see green, the most likely problem

is the local IP address. Verify that you have entered a valid local IP address for your
compulter.

TReK CFDP -- C:/Users/username/CFDP_lnstance_1.txt - m] ®
File ¥iew CFDP Options Help
Configuration: Configure | Operational: [l | Activate Deactivate
CFDP Commands =
Action  Transmission Source Remote EID Destination Add Row
Remove Row
Export List
Import List
<< Show Directory Default Destination: | C:/Usersfusername Clear All Restore All Execute All
Transactions =
Transaction [0 Action RemoteEID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
Configure... Clear Pause Resume Cancel
Message Area =

Figure 7 Configuration Status

9. Go to the File menu and save the configuration naming it CFDP_Instance_1. This
will update the application title bar and make it easier to distinguish between the two
instances once we have both instances running. This is shown in Figure 8.

14
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[ TReK CFDP — Ci/Users/username/CFDP_Instance_1.tct - m] ®
File ¥iew CFDP Options Help
Configuration: [l | Configure | Operational: [l = Actiate Deactivate
CFDP Commands =
Action  Transmission Source Remote EID Destination Add Row
Remove Row
Export List
Import List
<< Show Directory Default Destination: | C:/Usersfusername Clear All Restore All Execute All
Transactions =
Transaction [0 Action RemoteEID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
Configure... Clear Pause Resume Cancel
5 X

Message Area

GMT 2024-12-09 15:05:50:128 Info: Successfully activated CFDP service,

MActivated, Ready to Transfer Files

Figure 8 CFDP_Instance_1

10. Push the Activate button located in the Configuration Toolbar in the main window.
This will activate all the underlying services needed to perform CFDP functions. If
activation is successful, your main window should look like the one shown in Figure

9. The Operational Status will be green.

[ TReK CFDP -- Ci/Users/username/CFDP_Instance_.txt - ] X
Eile View CFDP Options Help
Configuration: . Configure | Operational: . Activate Deactivate
CFDP Commands g X
Action  Transmission Source Remote EID Destination Add Row
Remave Row
Export List
Import List
<< Show Directory Default Destination: | C:/Usersfusername ~ = Clear Al Restore Al | Execute Al
Transactions g X
Transaction |0 Action Remote EID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
Configure. .. Clear Pause Resume Cancel
Message Area 5 x
GMT 2024-12-09 15:00:10:270 Info: Configuration Ct/Users/username/CFDP_Instance_1.txt has been saved.
GMT 2024-12-09 15:00:13:931 Info: Successfully activated CFDP service.

Figure 9 CFDP_Instance_1 Activated

11. Now that one instance is configured and running, launch a second instance of the
CFDP application.

15
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12. In the second instance of the CFDP application, push the Configure button and update

the following as shown in Figure 10:

Local Entity ID: 2
Remote Entity ID: 1
Remote IP Address: <Your Local IP Address>
Remote Port: 4560
CFDP Socket Local Port: 4545
Configure ? X
Configuration: @ Mative CFDP O IOM CFDP
Mative CFDP Options Cryptography Summary
Local Entity ID: |2 |
Remote Entities
Remote EID  Remote [P Address  Remote Port Add
1 192.168.56.1 4560 Delete
CFDP Socket Local TP Address: [182.188.56.1 | | Browse...
CFDP Socket Local Port: [4545 |
CFDP Socket Queue Size: 1000 |
Ack Timeout (seconds): |15 |
Ack Limit: |25 |
Mak Timeout (seconds): |15 |
Nak Limit: 100 |
Nak Maximum PDU Packet Size (bytes): 16000 |
Inactivity Timeout {seconds): |3[JD |
Outgaing File Chunk Size (bytes): [1300 |
Aggregate File Transfer Rate (bits/sec): |1[JDDDD[JD |
Transaction Cyde Time Interval (milliseconds): |1 |
Steps Per Transaction Cycle: |1[J |
[ auto suspend and Resume
Mode: Peer to Peer Mode
Part: 45600
Connection Timeout (seconds): |2
Automatically Resize Mak Maximum PDU Packet Size if the Mak Packet Times Out
oK Cancel

Figure 10 Configuration for CFDP_Instance_2

Note: Now that you have configured both instances you can compare the configuration
information. You configured each instance with local entity information and remote

16
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entity information. Both instances have information needed to communicate with the
other. As areminder, the tutorial configuration is shown in Figure 11.

CFDP Instance 1
Entity 1D (EID) 1

Local Part 4560

CFDFP

<Your Local IP Address> [

2| ¥our Local IP Address>

CFDP Instance 2
Entity 1D (EID) 2

Local Port 4545

Figure 11 Tutorial Configuration Reminder

13. Push the OK button to save the configuration information and exit the dialog.

14. Verify the Configuration status is green.

15. Go to the File menu and save the configuration as CFDP_Instance 2.

16. Push the Activate button located in the Configuration Toolbar in the main window.
This will activate all the underlying services needed to perform CFDP functions. If
activation is successful, the main window for CFDP Instance 2 should look like the
one shown in Figure 12. The Operational Status will be green.
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E TReK CFDP -- C:/Users/username/CFDP_Instance_2.txt — O b4
File View CFDP Options Help

Configuration: . Configure | Operational: . Activate Deactivate
CFDP Commands =4
MAction Transmission Source  Remote EID  Destination Add Row
Remove Row
Export List
Import List
<< Show Directory Default Destination: | None w Clear all Restore All Execute Al
Transactions JF X
Transaction ID Action Remote EID  Status % Complete Bytes Transferred  Source Destination  Configuration  File Size
Configure... Clear Pause Resume Cancel
Message Area g X

GMT 2024-12-09 15:18:28:078 Info: Configuration C:/Users/username/CFDP_Instance_2.txt has been saved.
GMT 2024-12-09 15:18:2%:319 Info: Successfully activated CFDP service,

Figure 12 CFDP_Instance_2

17. You are now ready to transfer a file. The easiest way to identify the file(s) you want
to transfer is to use drag and drop to drop the file(s) into the main window CFDP
Commands list. To get some extra help from the application, you can set some
application defaults that will fill in information in the CFDP Commands list when
you drop files into the list. So before transferring a file, let’s set the defaults used by
drag and drop. Push the Configure button in the main window configuration toolbar.
Go to the Options tab. Set the Default Remote EID to 2 as shown in Figure 13.
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B8 Configure ? *

Configuration: (®) Native CFOP () ION CFDP

MNative CFDP Options Cryptography Summary

Default Remote EID: |2

Default Destination Paths
Destination Path Add
Delete
CFDP Dropbox List
Transmission Dropbox Path  Remote EID Destination Path - Retry Limit  Successful Path Add
Delete

Set Dropbox Path. ..

Set Successful Path. ..

Fragmentation Dropbox List

Dropbox Type Dropbox Path  Destination Path  File Fragmentation Size  Successful Path Add

Delete
Set Dropbox Path. ..

Set Successful Path...

[ Log Metrics
Log File Path:  |C:/Users jusername

Log File Name: |toolkit_cfdp_metrics

oK Cancel

Figure 13 CFDP Configuration Options Tab

18. Push the + button to add a row to the Default Destination Paths list. Enter the
absolute path for your home directory (<C:\Users\<your username> on Windows or
/home/<username> on Linux) on your computer. Your dialog should be similar to
the one shown in Figure 14.
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B8 Configure ? *

Configuration: (®) Native CFOP () ION CFDP

MNative CFDP Options Cryptography Summary

Default Remote EID: |2

Default Destination Paths
Destination Path Add
éC:_a’Users_a’usemame Delete

CFDP Dropbox List

Transmission Dropbox Path  Remote EID Destination Path - Retry Limit  Successful Path Add

Delete
Set Dropbox Path. ..

Set Successful Path. ..

Fragmentation Dropbox List

Dropbox Type Dropbox Path  Destination Path  File Fragmentation Size  Successful Path Add

Delete
Set Dropbox Path. ..

Set Successful Path...

[ Log Metrics
Log File Path:  |C:/Users jusername

Log File Name: |toolkit_cfdp_metrics

oK Cancel

Figure 14 Default Destination Path

When you drag and drop a file the Remote EID will automatically be populated for you
with the Default Remote EID. The Default Destination Paths will appear on the Default
Destinations menu in the application (more on this below).

19. Push the OK button to save the configuration information and exit the dialog.

20. In the main window under the CFDP Commands list, there is an option menu called
Default Destinations. Select the path you entered in the Default Destinations list in
the Configuration dialog (<C:\Users\<your username> on Windows or
/home/<username> on Linux). Your CFDP_Instance_1 main window should look
like the one shown in Figure 15.
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[ TReK CFDP — Ci/Users/username/CFDP_Instance_1.tct - m] ®
File ¥iew CFDP Options Help
Configuration: [l | Configure | Operational: [l = Actiate Deactivate
CFDP Commands =
Action  Transmission Source Remote EID Destination Add Row
Remove Row
Export List
Import List
<< Show Directory Default Destination: | C:/Usersfusername Clear All Restore All Execute All
Transactions =
Transaction [0 Action RemoteEID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
Configure... Clear Pause Resume Cancel
Message Area =
GMT 2024-12-09 15:00:10:270 Info: Configuration Ci/Users/username/CFDP_Instance_1.txt has been saved.
GMT 2024-12-09 15:00:13:931 Info: Successfully activated CFDP service.

Figure 15 Main Window with Default Destination Selected

21. Let’s transfer a file. Open a file explorer window and select a file to transfer. Make
sure it is not a file in your home directory since that is the destination of the file.
Drag the file from the file explorer window and drop it into the CFDP_Instance_1
CFDP Commands List. If all the information about the file is valid, your main
window should look similar to the one shown in Figure 16.

TReK CFDP -- C:/Users/username/CFDP_Instance_1.bct - m] X
File V¥iew CFDP Options Help
Configuration: [l | Configure | Operational: [l =~ Activate Deactivate
CFDP Commands =
Action  Transmission Source Remote EID Destination Add Row
put class2 Ci/cfdptest/filel et 2 C:/Users/username/filel ot Remove Row
Export List
Import List
<< Show Directory Default Destination: | C:/Usersfusername Clear All Restore All Execute All
Transactions =
Transaction [0 Action RemoteEID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
Configure... Clear Pause Resume Cancel
Message Area =
GMT 2024-12-09 15:00:10:270 Info: Cenfiguration Ci/Users/username/CFDP_Instance_1.txt has been saved.
GMT 2024-12-09 15:00:15:831 Info: Successfully activated CFDP service.

Figure 16 CFDP Commands List
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Let’s take a look at what we have in the list.

CFDP Command Syntax

[CEDP Directive] [Transmission] [source-path] [remote-EID] [destination-path]

CFDP Command

put class2 c:/cfdptest/filel.txt 2 C:/Users/username/filel.txt

Command Field

Value

Description

Action put Indicates the file will be ‘put’ (copied) from the local
entity (CFDP_Instance_1) to the remote entity
(CFDP_Instance 2)

Transmission class2 Class 2 ensures reliable file delivery; any required

retransmissions are requested and performed by CFDP.

Source C:/cfdptest/filel.txt Identifies the ‘source’ file you wish to transfer to the
destination (CFDP_Instance_2). (Note: Double quotes
are not required when entering data in the CFDP
Commands List.)

Remote EID 2 Identifies the remote entity ID is 2.

Destination C:/Users/username/filel.txt | Identifies the ‘destination’ file by providing the

absolute path and filename that should be used when
the file is placed at the destination. (Note: Double
quotes are not required when entering data in the CFDP
Commands List.)

22. Everything is ready to go. Push the Execute All button in the CFDP_Instance_1 main

window.

23. You should see the Transactions area populated with transaction information in both
the CFDP_Instance_1 main window and the CFDP_Instance_2 main window as
shown below in Figure 17 and Figure 18. Use the file explorer window to look at
your home directory and you should see the file you transferred.
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ﬂ TReK CFDP -- C:/Users/username/CFDP_Instance_1.bxt — O =
File View CFDP Options Help
Configuration: . Configure | Operational: . Activate Deactivate
CFDP Commands g X
Action  Transmission Source Remote EID Destination Add Row
Remove Row
Export List
Import List
<< Show Directory Default Destination: | C:/Usersfusername Clear Al Restore Al Execute Al
Transactions g X
Transaction ID Action RemoteEID  Status % Complete Bytes Transferred  Source Destination Configuration File Size
put 2 Success 100 12 C/cfdptest/filel. et C/Users/username/filel.txt Sender 12
Configure. .. Clear Pause Resume Cancel
Message Area g x
GMT 2024-12-09 15:34:21:294 Info: Successfully activated CFDP service. ~
GMT 2024-12-09 15:34:31:439 Info: Transaction started: 1_1 (cfdp_transceiver.cpp:617)
GMT 2024-12-09 15:34:31:440 Info: Transaction 1_1 (C:/cfdptest/filel.bet -> Ci/Users/username/filel.txt) (cfdp_transceiver.cpp:866)
GMT 2024-12-09 13:34:31:431 Info: Transaction 1.7 (Ci/cfdptest/filel.tet -> Ci/Users/username/filel txt): successful (cfdp_transceiver.cpp:26286) W
Figure 17 CFDP_Instance_1 Transaction Information
TReK CFDP -- C:/Users/username/CFDP_Instance_2.txt — O X
File View CFDP QOptions Help
Configuration: . Configure | Operational: . Activate Deactivate
CFDP Commands g X
Action Transmission Source  Remote EID  Destination Add Row
Remove Row
Export List
Import List
<< Show Directory Default Destination: | None ~ Clear all Restore All Execute All
Transactions g X
Transaction ID Action RemoteEID  Status % Complete Bytes Transferred  Source Destination Configuration  File Size
1 Success 100 12 C:/cfdptest/filel.txt C:/Users/username/filel.tct Receiver 12
Configure... Clear Pause Resume Cancel
Message Area g %
GMT 2024-12-09 15:34:2%:154 Info: Successfully activated CFDP service, ~
GMT 2024-12-09 15:34:31:43% Info: Transaction started: 1_1 (cfdp_transceiver.cpp:617)
GMT 2024-12-09 15:34:31:440 Info: Transaction metadata: 1_1 (Ci/cfdptest/filel.txt -> Ci/Users/username/filel.tt) (cfdp_transceiver.cpp:2007)
GMT 2024-12-08 15:34:31:447 Info: Transaction 1_1 (C:/cfdptest/filel.tet -» Ci/Users/username/filel.tet): successful (cfdp_transceiver.cpp:2686) ]

Figure 18 CFDP_Instance_2 Transaction Information
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That’s it! You have successfully transferred a file using CFDP. For more information
please see the TReK CFDP User Guide.

Happy Transferring!!!
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